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About This Document

This document describes BEA WebLogic XML/Non-XML Translator, hereafter
referred to as XML Translator, and provides instructions for using it to trandate data
from binary format to XML and from XML to binary format.

This document covers the following topics:

BEA WebL ogic XML/Non-XML Trandator Overview
Building Format Definitions

Testing Format Definitions

Using the Run-Time Component

Supported Data Types

Glossary

What You Need to Know

This document isintended mainly for application programmers and technical analysts
who perform data translations from binary to XML and XML to binary.
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e-docs Web Site

BEA product documentation is available on the BEA corporate Web site. From the
BEA Home page, click on Product Documentation or go directly to the “e-docs’
Product Documentation page at http://e-docs.bea.com.

How to Print the Document

Y ou can print acopy of thisdocument from aWeb browser, onefileat atime, by using
the File - Print option on your Web browser.

A PDF version of this document is available on the BEA WebL ogic XML/Non-XML
Trangator documentation Home page on the e-docs Web site (and also on the
documentation CD). Y ou can open the PDF in Adobe Acrobat Reader and print the
entire document (or a portion of it) in book format. To accessthe PDFs, open the BEA
WebLogic XML/Non-XML Translator documentation Home page, click the PDFfiles
button and select the document you want to print.

If you do not have the Adobe Acrobat Reader, you can get it for free from the Adobe
Web site at http://www.adobe.com/.

Related Information

The following BEA publications are also available:
m BEA WebLogic XML/Non-XML Translator Installation Guide
m BEA WebLogic XML/Non-XML Translator Getting Sarted Guide

m BEA Format Builder online help system
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Contact Us!

Y our feedback on the BEA WebLogic XML/Non-XML Translator documentation is
important to us. Send us e-mail at docsupport@bea.com if you have questions or
comments. Y our comments will be reviewed directly by the BEA professionals who
create and update the BEA WebL ogic XML/Non-XML Translator documentation.

In your e-mail message, please indicate that you are using the documentation for the
BEA WebLogic XML/Non-XML Translator 1.0.1 release.

If you have any questions about this version of BEA WebLogic XML/Non-XML
Trandator, or if you have problemsinstalling and running BEA WebL ogic
XML/Non-XML Translator, contact BEA Customer Support through BEA
WebSupport at www.bea.com. Y ou can also contact Customer Support by using the
contact information provided on the Customer Support Card, which isincluded in the
product package.

When contacting Customer Support, be prepared to provide the following information:
m  Your name, e-mail address, phone humber, and fax number

m Your company name and company address

®m Your machine type and authorization codes

m  The name and version of the product you are using

m A description of the problem and the content of pertinent error messages

Documentation Conventions

The following documentation conventions are used throughout this document.

Convention Item

boldfacetext  Indicatesterms defined in the glossary.
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Convention

Item

Ctrl+Tab Indicates that you must press two or more keys simultaneoudly.
italics Indicates emphasis or book titles.
nonospace Indicates code samples, commands and their options, data structures and
t ext their members, data types, directories, and file names and their extensions.
Monospace text also indicates text that you must enter from the keyboard.
Examples:
#include <iostreamh> void main ( ) the pointer psz
chnod u+w *
\tux\ dat a\ ap
. doc
t ux. doc
Bl TMAP
fl oat
nonospace Identifies significant words in code.
bol df ace Example:
t ext . .
void commt ()
nonospace Identifies variables in code.
italic Example:
t ext .
String expr
UPPERCASE Indicates device names, environment variables, and logical operators.
TEXT Examples:
LPT1
SIGNON
OR
{1} Indicates a set of choicesin asyntax line. The braces themselves should

never be typed.

Indicates optional itemsin asyntax line. The brackets themselves should
never be typed.

Example:

bui | dobjclient [-v]
[-1 file-list]...

[-0 name | [-f file-list]...
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Convention

Item

Separates mutually exclusive choicesin asyntax line. The symbol itself
should never be typed.

Indicates one of the following in acommand line:

m  That an argument can be repeated several timesin acommand line

m  That the statement omits additional optiona arguments

m  That you can enter additional parameters, values, or other information
The dlipsisitself should never be typed.

Example:

buil dobjclient [-v] [-0 name ] [-f file-list]...
[-1 file-list]...

Indicates the omission of items from a code example or from a syntax line.

The vertical ellipsisitself should never be typed.

BEA WebLogic XML/Non-XML Translator User Guide
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CHAPTER

1

BEA WebLogic

XML/Non-XML
Translator Overview

Within most enterprise application integration (EAI) problem domains, data
tranglation is an inherent part of an EAI solution. XML is quickly becoming the
standard for exchanging information between applications, and isinvaluable in
integrating disparate applications. However, most data transformation engines do not
support trand ations between binary data formats and XML. BEA WebL ogic
XML/Non-XML Trandator (hereafter referred to as XML Tranglator) providesfor an
exchange of information between applicationsby supporting datatransl ations between
binary formats from legacy systemsand XML.

This section provides information about the following topics:
m  Understanding XML Translation
m What is XML Trandator?

e The Design-Time Component

e The Run-Time Component

m Post Translation Options and Considerations
e Performing XML Transformation
e Working with BEA WebL ogic Process | ntegrator

m  Getting Started with the BEA WebL ogic XML/Non-XML Trandlator
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1 BeA WebLogic XML/Non-XML Translator Overview

Understanding XML Translation

Datathat is sent to, or received from, legacy applicationsis often platform-specific
binary data that isin the native machine representation. Binary datais not
self-describing, so in order to be understood by an application, the layout of this data
(metadata) must be embedded within each application that uses the binary data.

XML is becoming the standard for exchanging information between applications
because XML embeds a description of the data within the data stream, thus allowing
applications to share data more easily. XML is easily parsed and can represent
complex data structures. As aresult, the coupling of applications no longer requires
metadata to be embedded within each application.

Whenyoutranslate binary to XML data, you convert structured binary datato an XML
document so that the data can be accessed via standard XML parsing methods. Y ou
must create the metadata used to perform the conversion. The translation process
converts each field of binary datato XML according to the metadata defined for each
field of data. In the metadata you specify the name of thefield, the datatype, the size,
and whether the field is always present or optional. It isthis description of the binary
datathat is used to translate the binary datato XML. Figure 1-1 shows a sample of
XML datatranslation.

Figure1-1 XML Data Trandation of: Tom;Jones;1345;19;

Translated to XML

=X ML wersion="1.0"7=

. <Employes:
B D=t
tnary = | Mon-EhiL to Xkl o| sFName:Tom</FNamex>
Tom:Jones: 13d6:19: 7 Translatar "l «LHame=Jones</LHamex
<EmpHNum=1345/EmpHum:=

“lobGradex19<ilobGrades
Metadata <Employeer

Cescription of
Binany [ ata

Applications devel oped on the WebL ogic platform often use XML asthe standard data
format. If you want the data from your legacy system to be accessible to applications
on the WebL ogi ¢ platform, you may use XML Tranglator to translate it from binary to
XML or from XML to binary. If you need the XML in a particular XML dialect for
end use, you must transform it using an XML data mapping tool.
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What is XML Translator?

What is XML Translator?

XML Trandlator facilitates the integration of datafrom diverse enterprise applications
by supporting datatrand ations between binary formatsfrom legacy systemsand XML.
XML Translator normalizeslegacy datainto XML so it may be directly consumed by
XML applications, transformed into aspecific XML grammar, or used directly to start
workflowsin BEA WebL ogic Process | ntegrator. XML Translator supports non-X ML
to XML translation and vice versa and is made up of two primary components:

m  The Design-Time Component
m  The Run-Time Component

To perform atrandation, you create a description of your binary datausing the
design-time component (Format Builder). Thisinvolves analyzing binary data so that
itsrecord layout is accurately reflected in the metadata you create in Format Builder.
Y ou then create a description of theinput datain Format Builder and save this
metadata as a Message Format Language (MFL) document.

Y ou can then use XML Trandator’ s run-time component to trandlate instances of
binary datato XML. Figure 1-2 shows the event flow for non-XML to XML data
translation.

Figure1-2 Event Flow for Non-XML to XML Transation Usng XML

Translator
BEA XML
Translator Run-
BEA XML Translator Design-Time Phase Time Phase

! 1 2 3 | : 4 !

' You analze ' : Youtranslate || WL
1| binary data to Dﬁfgﬁglogis Format ! 1| instancesof | —* pacyment |
' | determine the ¥ U cregte ' Builder |, MEL 1| binarydatato ||

| layotand % 7 ™ crestesan | Document ML usingthe ||

| inary types of metadata MFL , | binary data and |1

1| each field of umgg_:—:ﬂormat document | S '| the matching |1

o data uliner | || MFL Metadata |

i | Binary : :

o o e aao ool Data L e e
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1 BeA WebLogic XML/Non-XML Translator Overview

The Design-Time Component

The design-time component is a Java application called Format Builder. Format
Builder isused to create descriptionsof binary datarecords. Format Builder allowsyou
to describe the layout and hierarchy of the binary data so that it can be translated to or
from XML. With Format Builder, you can describe sequences of bytes asfields. Each
field description includes the type of data (floating point, string, etc.), the size of the
data, and the name of the field. Format Builder allows you to further define groupings
of fields (groups), repetition of fields and groups, and aggregation.

The description you create in Format Builder is saved in an XML grammar called

M essage Format Language (MFL). MFL documentsare metadata used by therun-time
component of XML Translator to translate an instance of a binary datarecord to an
instance of an XML document (or vice-versa). Figure 1-3 shows the process flow of
binary and XML data through Format Builder during the design-time phase.

Figure 1-3 Design Time Process Flow through Format Builder

_____________________________________________________

The metadata you create i
' in Format Builder is saved |
hinary data, create as an MFL docurnent. It

metadata using and the hinary data are

Formmat Builder ready to be processed by |
the run-time companeant

Analyze binary
data to determine
the layout and
hinary types af
each field of data

Baszed on your
analysis ofthe

Binary
Data

:
1
Format Builder | |
1
1
1

Y ou can also use Format Builder to retrieve, validate, and edit stored MFL documents
and to test message format definitions with your own data. The test feature allows you
to select the option of testing the translation of XML datato binary format, or binary
datato XML format. Y ou may save the transformed datato afile for future testing.
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The Run-Time Component

The run-time component of XML Translator isaJavaclasswith various methods used
to translate data between binary and XML formats. This Java class can be deployed in
an EJB using BEA WebL ogic Server, invoked from aworkflow in BEA WebL ogic
Process Integrator or integrated into any Java application. Figure 1-4 shows the
run-time process flow for binary to XML translations and XML to binary translation.

Figure1-4 Run-Time Process Flow

Binary to XML

Binary
Data

BEA XML
Translator
Java Classes

XML
Document

v

MFL Document

N

XML to Binary

XML
Document

BEA XML Binary

\ Translator
/ Java Classes Data

h 4

MFL Document

S

Binary to XML Translation
Listing 1-1 isacode samplethat showsthe parsing of afile containing binary datainto

an XML document object. The MFL filenynf | . nf 1 isused as the description of the
binary data contained in the file nybi nar yfil e.
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1 Bea WebLogic XML/Non-XML Translator Overview

Listing1-1 Sample Codefor Binary to XML Trandation

i mport com bea.w xt.*;

i mport org.w3.dom Docunent ;
import java.io.FilelnputStream
i mport java.net. URL;

try
{
WLXT W xt = new WLXT();

URL nfl Docunent Nane = new URL("file:nynfl.nfl");
FilelnputStreamin = new Fil el nput Stream("nybi naryfile");

Docurment doc = w xt. parse(nfl Document Narme, in, null);

catch (Exception e)
{

e.printStackTrace(Systemerr);

}

XML to Binary Translation

Listing 1-2 is a code sample that shows the translation of the XML data contained in
thefilemyxm . xnl to the binary format specified by the MFL document nynf | . nfl .
The binary dataiswritten to thefilenybi naryfil e.

Listing 1-2 Sample Codefor XML to Binary Trandation

i mport com bea. w xt.*;

import java.io.FilelnputStream
import java.io.FileQutputStream
import java.net.URL;

try
{
WLXT W xt = new WLXT();

URL nfl Docunent Nanme = new URL("file:nynfl.nfl");
FilelnputStreamin = new Fil el nput Stream("nyxm .xm");

Fi | eCut put Stream out = new Fi | eQut put St rean(" nmybi naryfile");
w xt . serialize(nfl Docurent Name, in, out, null);

catch (Exception e)
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Post Translation Options and Considerations

{
}

e.printStackTrace(Systemerr);

Post Translation Options and Considerations

After you have successfully translated your binary datato XML, or vice versa, you
have numerous optionsfor additional processing of the XML data. The XML datacan
be transformed to a specific XML dialect or to adisplay format. The XML datacan be
sent to other applications that consume XML such as WebL ogic Process I ntegrator.
Once your binary data has been put in a self-describing format such as XML, thisdata
isavailable for usein other applications.

Performing XML Transformation

Once you have trandated binary datainto XML, you may need to transform the XML
datato adifferent XML grammar, to a display format (HTML), or to another binary
format. The process of transforming XML to another XML grammar isreferred to in
this document as XML transformation. XML transformation can be accomplished via
third-party tools such as Apache’'s Xalan XSLT engine. Y ou might want to transform
XML for several reasons:

m  Transform the XML to a specific XML dialect (RosettaNet or ebXML)
m  Transform the XML to adisplay format (HTML)

m  Transform the XML so that it matches another MFL document and can be
converted to adifferent binary format by XML Translator

XSL (extensible stylesheet language) is an XML language that describes a series of
transformationsthat are to be performed on nodes of an XML document. A stylesheet
isan XSL document that can be used to map an XML document to another XML
dialect or to another text format (suchasHTML or PDF). A stylesheet can also be used
with the run-time component of XML Translator to transform XML.

BEA WebLogic XML/Non-XML Translator User Guide 1-7



1 BeA WebLogic XML/Non-XML Translator Overview

Figure 1-5 demonstrates one XML grammar converted to another using an XSLT
engine. The transformation metadata in this case isan XSL style sheet that describes
how one XML grammar is mapped into another.

Figure 1-5 XML Data Transformation of: Tom;Jones,1345;19

XML Transform
Metadata (XSL)

XML Source

¥ inati
=7THML version="1 0"7?= ¥ML Destination
=Employee= XML =7¥ML wersion="1.0"7=
=FMame=Tom=FMame:= | Transformatior o =EmpData=
=Liames=Jonesz=LMame= o Engine (XSLT) =mlame=Tom Jones-=hlame:=
=Emprum=1 345 Emphurm= =dobCode=1345 Sales=ilobCode=
=JobGrade=19=,lohGrade= =EmpData=
=Employes=

Working with BEA WebLogic Process Integrator

BEA WebL ogic Process Integrator is a powerful workflow engine that automates
workflow, business-to-business processes, and enterprise application assembly.
WebL ogic Process Integrator runs on BEA WebL ogic Server and is arobust J2EE
standards-based workflow and process integration solution.

Using an intuitive flowchart paradigm, business anaysts use the WebL ogic Process
Integrator Studio to define business processes that span applications or to automate
human interaction with applications. Devel opers can use WebL ogic Process | ntegrator
to assemble application components quickly without programming. The assembled
applications are executed and managed by the WebL ogic Process Integrator engine.

A sampleapplicationisincluded with XML Transl ator that demonstrates how you can
integrate it with WebL ogic Process Integrator. The sample application is a workflow
that simulatesintegration with legacy HR and payroll systemsthat do not accept XML.
In the sample application, an XML document from a JM Stopic or amanual form entry
isused toinitiate the creation of paychecksfor employees. The document containsthe
employee number, hoursworked, and pay period ending date. The employee name and
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pay rate must be extracted from the HR system. The pay is calculated and then sent to
the payroll system. Neither the HR nor payroll systems accept XML data. Included
with the sample are the following:

m  EJB wrapper for XML Translator Java classes
m EJBsthat simulate HR and payroll legacy applications
m  Pre-built WebL ogic Process Integrator workflow

For detailed information about using the sample application, see BEA WebLogic
XML/Non-XML Trandator Samples Guide.

Getting Started with the BEA WebLogic
XML/Non-XML Translator

The steps outlined in Table 1-1 provide you with a high-level guidelineto all of the
tasks and processes that you must perform to install, configure, and work with the
XML Trandator. Think of these steps as a road map to guide you through the process
and to point you to the resources available to help you.

Table1-1 Sepsfor Working with the XML Translator

Task Resource

1. Readthe BEA WebLogic BEA WebLogic XML/Non-XML Translator
XML/Non-XML Trandator Release  Release Notes.

Notes.

2. Make surethat al of the BEA WebLogic XML/Non-XML Translator
platform/environment prerequisites  ReleaseNotesand BEA WebL ogic XML/Non-XML
listed in the Installation and Trandator Installation and Configuration Guide.
Configuration Guide and in the
Release Notes have been met.

3. Install the BEA WebLogic BEA WebLogic XML/Non-XML Trandator
XML/Non-XML Tranglator. Installation and Configuration Guide.

BEA WebLogic XML/Non-XML Translator User Guide 1-9



1 BeA WebLogic XML/Non-XML Translator Overview

Task Resour ce
4. Definethedataformat usingFormat  BEA WebLogic XML/Non-XML Trandator User
Builder and generate trandation Guide.
metadata.
5. Test thetrandation BEA WebLogic XML/Non-XML Translator User
Guide.
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CHAPTER

2

Building Format
Definitions

The following sections provide information on building format definitions using the
Format Builder included with BEA WebLogic XML/Non-XML Trandator (hereafter
referred to as XML Tranglator):

m  Understanding the Data Formats Used with XML Trandator
m  Analyzing the Datato be Trandated
m  Using the Format Builder

The Format Builder included with XML Trandator allows users to build format
definitions for binary datathat will be trandated to or from XML. Format definitions
are the metadata used to parse or create binary data.

BEA WebLogic XML/Non-XML Translator User Guide 2-1



2

Building Format Definitions

Understanding the Data Formats Used with
XML Translator

To understand how the Format Builder is used, it helps to understand the data formats
used by XML Trandator: binary data, XML, MFL, DTD and Schema.

About Binary Data (Non-XML Data)

2-2

Because computers are based on the binary numbering system, applications often use
abinary format to represent data. A file stored in binary format is computer-readable
but not necessarily human-readable. Binary formats are used for executable programs
and numeric data, and text formats are used for textual data. Many files contain a
combination of binary and text formats. Such files are usually considered to be binary
files even though they contain some data in a text format.

Unlike XML data, binary datais not self-describing. In other words, binary data does
not provide a description of how the data is grouped, divided into fields, or arranged
inalayout. Binary datais a sequence of bytesthat can be interpreted as an integer, a
string, or a picture, depending on the intent of the application that generates the
sequence of bytes. In order for binary datato be understood by an application, the
layout must be embedded within each application that uses this data. Binary data may
also be embedded using different character sets. For example, character data on an
IBM mainframeis usually encoded using the EBCDIC character set while datafrom a
desktop computer is either ASCII or unicode.

The Format Builder is used to create a Message Format Language (MFL) file that
describes the layout of the binary data. MFL isan XML language that includes
elements to describe each field of data, as well as groupings of fields (groups),
repetition, and aggregation. The hierarchy of a binary record, the layout of fields, and
the grouping of fields and groups are expressed in an MFL document. This MFL
document is used by XML Tranglator at run-time to translate the data to and from an
XML document.
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Listing 2-1 Example of Binary Data

1234; 88844321; SUP: 21Spr ockl ey’ s Sprocket s01/15/ 2000123 Main St.;
Austi n; TX; 75222; 555 State St.; Austin; TX; 75222; PO12345678; 666123; 150; Red
Spr ocket ;

About XML Documents

Extended Markup Language, or XML, is atext format for exchanging data between
different systems. It allows datato be described in asimple, standard, text-only format.
In contrast to binary data, XML data embeds a description of the data within the data
stream. Applications can share data more easily, since they are not dependent on the
layout of the data being embedded within each application. Since the datais presented
in astandard form, applications on disparate systems can interpret the datausing XML
parsing tools, instead of having to interpret datain proprietary binary formats.

Instances of XML documents contain character data and markup. The character data
isreferred to as content, while the markup provides hierarchy for that content. Markup
is distinguished from text by angle brackets. Information in the space between the “<*
and the“>" isreferred to as the tags that markup the content. Tags provide an
indication of what the content is for, and a mechanism to describe parent-child
relationships. Listing 2-2 shows an example of an XML document.

Listing 2-2 Example of XML Document

<?xm version="1.0"7?>
<Pur chaseRequest >
<PR_Nunber >1234</ PR_Nunber >
<Suppl i er | D>88844321</ Supplier _| D>
<Suppl i er _Nanme>Spr ockl ey&apos; s Spr ocket s</ Suppl i er _Name>
<Request ed_Del i very_Dat €>2000- 01- 15T00: 00: 00: 000</ Request ed_Del i very_Dat e>
<Shi ppi ng_Addr ess>
<Addr ess>
<Street>123 Main St.</Street>
<City>Austin</City>
<St at e>TX</ St at e>
<Zi p>75222</ Zi p>
</ Addr ess>
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</ Shi ppi ng_Addr ess>
</ Pur chaseRequest >

An XML document can conform to acontent model. A content model allows Metadata
about XML documents to be communicated to an XML parser. XML documents are
saidto bevalid if they conform to acontent model. A content model describesthe data
that can exist in an instance of an XML document. A content model also describes a
top-level entity, whichisasegquence of subordinate entities. These subordinate entities
arefurther described by their tag names and data content. The two standard formatsfor
XML content models are XML Document Type Definition (DTD) and XML Schema.
A Schemais an XML document that defines what can be in an XML document. A
DTD aso defines what content can exist in an XML document, but the Schema
definitionismore specific than the DTD, and provides much finer-grained control over
the content that can exist in an XML document.

Listing 2-3 shows an example of a Document Type Definition. Listing 2-4 shows an
example of an XML Schema.

Listing 2-3 ExampleDTD

<! ELEMENT Pur chaseRequest

(PR_Nunber, Supplier_I D, Supplier_Nane?, Request ed_Del i very_Dat e, Shi ppi ng_Addr ess,
Bi | | i ng_Address, Paynent _Ter ns, Purchase_| tens) >

<! ELEMENT PR_Nunber (#PCDATA) >

<I ATTLI ST PR _Nunber type CDATA #FI XED "nonNegati vel nt eger" >
<! ELEMENT Supplier_| D (#PCDATA) >

<I ATTLI ST Supplier_I D type CDATA #FI XED "nonNegati vel nt eger">
<! ELEMENT Suppl i er _Nane (#PCDATA) >

<! ATTLI ST Supplier_Nane type CDATA #FI XED "string">

<! ELEMENT Requested_Delivery_Date (#PCDATA) >

<I ATTLI ST Requested_Delivery_Date type CDATA #FI XED "ti mel nstant">
<! ELEMENT Shi ppi ng_Addr ess ( Address) >

<! ELEMENT Address (Street,City, State, Zi p)>

<! ELEMENT Street (#PCDATA) >

<I ATTLI ST Street type CDATA #FI XED "string">

<! ELEMENT City (#PCDATA) >

<IATTLI ST Gty type CDATA #FI XED "string">

<I ELEMENT State (#PCDATA) >

<I ATTLI ST State type CDATA #FI XED "string">

<! ELEMENT Zi p (#PCDATA) >

<I ATTLI ST Zi p type CDATA #FI XED "nonNegati vel nt eger">
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Listing 2-4 Example XML Schema

<?xm version="1.0" encodi ng="UTF-8""?>

<xsd:
<xsd:
<xsd:

Thi s

schema xm ns: xsd="htt p://ww. w3. or g/ 1999/ XM_.Schena" >
annot ati on>

docunent ati on>

schema created for MFL MessageFor mat PurchaseRequest.

</ xsd: docunent ati on>
</ xsd: annot ati on>

<xsd:
<xsd:
<xsd:
<xsd:
<xsd:
<xsd:
<xsd:
<xsd:

el ement nanme="Pur chaseRequest ">

conpl exType content="el emrent Onl y">

sequence>

el ement ref="PR Nunber" m nCccurs="1" maxCccurs="1"/>

el enent ref="Supplier_ID'" mnOccurs="1" maxCccurs="1"/>

el enent ref="Supplier_Nanme" m nCccurs="0" maxCccurs="1"/>

el enent ref="Requested_Delivery_Date" nmi nCccurs="1" maxCccurs="1"/>
el enent ref="Shi ppi ng_Address" m nCccurs="1" nmaxQccurs="1"/>

</ xsd: sequence>
</ xsd: conpl exType>
</ xsd: el ement >

<xsd

<xsd:
<xsd:
<xsd:

<xsd:
<xsd:
<xsd:
<xsd:

el enent nane="PR_Nunber" type="xsd: nonNegati vel nteger"/>

el enent nane="Supplier_I D' type="xsd: nonNegativel nteger"/>

el enent nane="Supplier_Nanme" type="xsd:string"/>

el enent nane="Requested_Del ivery_Date" type="xsd:tinelnstant"/>

el enent nane="Shi ppi ng_Addr ess" >

conpl exType content="el emrent Onl y">

sequence>

el enent ref="Address" m nQccurs="1" maxCOccurs="1"/>

</ xsd: sequence>
</ xsd: conpl exType>
</ xsd: el ement >

</ xsd: schema>
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About MFL Documents

Message Format Language (MFL) isan XML language that describes the layout of
binary data. This language includes elementsto describe each field of data, as well as
groupings of fields (groups), repetition, and aggregation. The hierarchy of a binary
record, the layout of fields, and the grouping of fields and groupsis expressed in an
MFL document. MFL documents are created using Format Builder. These MFL
documents are then used to perform run-time tranglation. MFL documents are created
for you when you define and save definitions from within Format Builder.

The MFL documents you create using Format Builder can contain the following
elements:

m Message Format — Thetop level element. Defines the message name and MFL
version.

m  Field — Sequence of bytesthat have some meaning to an application. (For
example, the field EMPNANME contains an employee name.) Defines the formatting
for the field. The formatting parameters you can define include:

e Tagged — Indicates that aliteral precedes the data field, denoting the
beginning of the field.

e Length — Indicates that alength value precedes the data field, denoting the
length of thisfield.

e Occurrence — Repeating fields appear more than once in the message
format. You can set a specific number of times the field isto repeat, or define
adelimiter to indicate the end of the repeating field.

e Optional — The field may or may not be present in the named message
format.

m  Groups — Collections of fields, comments, and other groups or references that
arerelated in some way (for example, the fields PAYDATE, HOURS, and RATE
could be part of the PAYI NFOgroup). The parameters you can define include:

e Occurrence — Repeating groups appear more than once in the message
format: You can set a specific number of times the group isto repeat, or
define a delimiter to indicate the end of the repeating group.

e Choice of Children — Defining a group as “ Choice of Children” means that
only oneitem in the group will appear in the message format.
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e Optional — The group of data within this structure may or may not be
present in the named message format.

m  References — Indicate that another instance of the field or group format exists
in the data. Reference fields or groups have the same format as the original field
or group, but you can change the optional setting and the occurrence setting for
the reference field or group. For example, if you have a bill to address and a ship
to address in your data, you only need to define the address format once. Y ou
can create the bill to address definition and create a reference for the ship to
address.

m  Comments — Notes or additional information about the message format.

Analyzing the Data to be Translated

Before a message format can be created, the layout of the binary data must be
understood. Legacy purchase order sample data and corresponding MFL and XML
documentsfor apurchase order record areincluded onthe XML Translator CD-ROM.
The sample purchase order illustrates how XML Tranglator trand ates data from one
format to another. For more information on this sample data, refer to the BEA
WebLogic XML/Non-XML Trandator Samples Guide.

Thekey totrandlating binary datato and from XML isto create an accurate description
of the binary data. For binary data (data that is not self-describing), you must identify
the following elements:

m Hierarchical groups
m  Group attributes, such as name, optional, repeating, delimited
m Datafields

m Datafield attributes, such as name, datatype, |ength/termination, optional,
repeating

The Format Builder (the design-time portion of XML Tranglator) is used to build the
format definitionsthat are used for data trandlations. For details on the steps you need
to perform to thoroughly analyze your data, refer to the BEA WebLogic
XML/Non-XML Trandator Samples Guide.
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Using the Format Builder

Format Builder assists you in creating format descriptions for binary data. Y ou use
Format Builder to create hierarchical and detail information derived from structura
and detailed analysis of your data. These format descriptions are stored in an MFL
document. Y ou can also use Format Builder to test your format descriptionsbeforeyou
apply them to your actual data.

Starting Format Builder

To start Format Builder, choose Start — Programs — BEA WebL ogic E-Business
Platform — Format Builder. The Format Builder main window displays. If you did not
use the installation directory defaults, your path may be different.

Using the Format Builder Main Window

The main window of Format Builder is split into two panes. The left pane (the Tree
Pane) shows the structural information for the data format. The right pane (the
Properties Pane) shows the detail for the item selected in the tree pane.
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Figure2-1 Format Builder Main Window
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i rMessage Format Properties

The structure of the binary dataisdefined in the tree pane using acombination of fields
and groups that match the target data.

Thefollowing topicsdiscussthe parts of the main window and provideinstructionsfor
navigating and executing commands from the main window of Format Builder:

m Using the Tree Pane
m Using the Menu Bar
m Using the Toolbar

m Using Drag and Drop

m Using the Shortcut Menus
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Using the Tree Pane

The Tree Pane represents hierarchical/structural information about the format of the

binary datain atree. The root node of the tree will correspond to the MFL document
being created or edited. The root nodeisreferred to as the Message node. Child nodes
are labeled with group or field names. Fields are represented by leaf nodesin thetree.
Groups contain fields or other groups and are represented by non-leaf nodesin thetree.

Theicon for each node encapsul ates information about the node. The icon indicates
whether the node represents amessage, agroup, afield, acomment, or areference. The
icon also indicates whether a group or field is repeating, whether a group is a Choice
of Children, and whether agroup or field is optional or mandatory. Y ou also have the
ability to add, delete, move, copy, or rename nodesin thetree. Thisisdone through the
menus or the toolbar (see Using the Menu Bar and Using the Toolbar).

Theiconsthat appear in the Tree Pane are described in the following table.

Table 2-1 Treelcon Descriptions

Treelcon  lcon Name Description
Message Format The top level element.
frrd]
Group Collectionsof fields, comments, and other
lj groups or references that are related in

some way (for example, the fields
PAYDATE, HOURS, and RATE could be part
of the PAYI NFO group). Defines the
formatting for all items contained in the

group.

Optional Group A group that has O or more occurrences.
]

Repesating Group A group that has one or more occurrences.

Optional Repeating Group ~ May or may not be included, but if
:’@I‘; included, more than one will occur.
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Table 2-1 Treelcon Descriptions

Treelcon Icon Name

Description

Group Reference

o

Indicates that another instance of the
group existsinthe data. Reference groups
have the same format as the origina
group, but you can change the optional
setting and the occurrence setting for the
reference group.

Choose Choice of Childrenif only one of
the items in the group will beincluded in
the message format.

Sequence of bytesthat have some
meaning to an application. (For example,
the field EMPNAME contains an employee
name.) Defines the formatting for the
field.

A field that may or may not be present.

A field that has one or more occurrences.

Group Choice
Field

Optional Field
Repeating Field
Field Reference

Indicatesthat another instance of thefield
existsin the data. Reference fields have
the same format as the original field, but
you can change the optional setting and
the occurrence setting for the reference
field.

Optional Repeating Field

A field that has O or more occurrences.

Comment

Contains notes about the message format
or the data translated by the message
format.
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Table 2-1 Treelcon Descriptions

Treelcon  lcon Name Description
Collapse A minus sign next to an object indicates
= that it can be collapsed.
Expand A plussign next an object indicatesthat it
can be expanded to show more objects.

Using the Menu Bar

The Menu bar displays the menu headings. The menu itemsthat are available depend
on what is selected in the tree pane and the state of the tree. Click a menu heading to
open the menu and choose a command.

Figure2-2 Format Builder Menu Bar
File Edit Insert View Tools Test Help
Note: Menu itemsthat appear in gray are unavailable for the current selection.

For a complete description of the menu commands, see Format Builder Menus.

Using the Toolbar

2-12

Thetoolbar provides buttons that access some of the frequently used commandsin the
menus. To activate acommand, click its toolbar button. If acommand is unavailable,
its button appears grayed-out.

Figure2-3 Format Builder Toolbar
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The toolbar buttons provided with Format Builder are described below:

Toolbar Button  Name Description
D New Creates a new Message Format.
'ﬂ Open Opens an existing Message Format.
H Save Saves the current M essage Format.
ﬁ Cut Removes theitem currently selected in the
left-hand pane, and it’ s child objects, from thetree.

The item can be pasted elsewhere in the tree.

Note:  Thisactionisnot availableif the Message
Format (root) item is selected.

Copy Makes a copy of the item currently selected in the
left-hand pane for insertion elsewhere in the tree.

(e

Note: Thisactionisnot availableif the Message
Format (root) item is selected.

ﬁl Paste as Inserts the cut or copied item as asibling object of
Sibling the selected item.
@ Paste as Inserts areference to the cut or copied item asa
Reference sibling object of the selected item.
) Undo Reverses the previous action. The tool tip changes

to indicate the action that can be undone. For
example, changing the name of afield to Address
and clicking Apply causes the tool tip to read
“Undo Apply Field Address’. Format Builder
supports multi-level undoing and redoing.
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Toolbar Button Name

Description

Redo
(1

Reverses the effects of an Undo command. The
tool tip changes to indicate the action that can be
redone. For example, changing the name of afield
to Address and then undoing that action causesthe
tool tip to read “Redo Apply Field Address”.
Format Builder support multi-level undoing and
redoing.

g Insert Field

Insertsafield asasibling of theitem selected inthe
tree pane.

Insert Group

<D

Inserts agroup asasibling of theitem selected in
the tree pane.

Insert
Comment

W

Inserts acomment as a sibling of theitem selected
in the tree pane.

Move Up

Moves the selected item up one position under its
parent.

Move Down

Moves the selected item down one position under
its parent.

Promoteitem

| & =

Promotesthe selected item to the next highest level
in the tree. For example, Field1 isthe child object
of Groupl. Selecting Field1 and clicking the
Promote tool makesit a sibling of Groupl.

Demoteitem

Demotes the selected item to the next lower level
in the tree. For example, Groupl is the sibling of
Fieldl. Fieldl immediately follows Groupl in the
tree. Selecting Field1 and clicking the Demote tool
makes it achild of Groupl.

Expand

Expands all items in the tree pane to show child
items.
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Toolbar Button Name

Description

= Collapse

Collapses the tree pane to show first level items
only.

Using the Shortcut Menus

Instead of using the standard menusto find the command you need, use the right mouse
button to click an item in the tree pane. The menu that appears shows the most
frequently used commands for that item.

The following commands are available from the Shortcut Menus.

Note: Somecommandsmay be unavailable, depending on theitem you have selected
inthetree, or the state of the tree at the time.

Table 2-2 Shortcut Menus

Menu Command Description

Cut Removes the item currently selected in the left-hand pane,
and it's child objects, from the tree.

Copy Makes a copy of the item currently selected in the left-hand
pane for insertion elsewherein the tree.

Paste Inserts the cut or copied item. An additional menu displays
when you select Paste. Y ou can chooseto pastetheitem asa
child or sibling of the selected item. In addition, you can
choose to paste areference to the cut or copied item asa
sibling of the selected item.

Insert Group Inserts anew group. Y ou select whether to insert the group
as achild or sibling of the selected item.

Insert Field Insertsanew field. Y ou select whether to insert thefield asa

child or sibling of the selected item.

Insert Comment

Insertsacomment. Y ou select whether to insert the comment
as achild or sibling of the selected item.
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Menu Command

Description

Duplicate

Makes a copy of the currently selected item. The duplicate
item containsthe same values asthe original item. The name
of the duplicate item is the same as the original item name,
with the word “New” inserted before the original name. For
example, duplicating agroup caled “Groupl” resultsin a
group with the name “NewGroupl”.

When you duplicate an item with anumeric valuein its
name, the new item name contains the next sequential
number. For example, duplicating “NewGroupl” resultsin a
group named “NewGroup2”.

Delete

Deletes the selected item.

Using Drag and Drop

Y ou can use the drag and drop feature of XML Trandator to copy and/or move the

itemsin the tree pane.

Note: Thenode being copied or moved isawaysinserted asasibling of the selected
node during the drag and drop process.

To use drag and drop to move an item:

1
2.
3.

Select the item you want to move.
Press and hold the left mouse button while you drag the item to the desired node.

When the item isin the desired location, release the left mouse button. The item

is moved to the new location.

To use drag and drop to copy an item:

1
2.
3.

Select the item you want to copy.
Pressand hold the CTRL key.
Keeping the CTRL key depressed, press and hold the left mouse button while you

drag the item to the desired node.

With the sibling object selected, release the left mouse button. A copy of theitem

is placed at the new location.
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Creating a Message Format

Thefirst step in creating aMessage Format Definition fileisto create amessage format
(the root node of a message format file).

To create a message format:

1. Choose File » New. The Message Format Pane displays in the detail window.

Figure2-4 Message Format Properties

Message Format Properties

Hame |PurchaseRequest

ersion| 2.00

o || s

2. Enter datain the fields as described in the following table.

Note: The previous example and the examplesthat follow are based on MFL version
2.0 documents.

Table 2-3 Message Format Properties

Field Description

M essage Format Properties

Name The name of the message format. This value will be used as the root
element in the translated XML document. This name must comply
with XML element naming conventions.

Version The version of MFL you are using. Version 1.0 of MFL was
introduced with BEA eLink Information Integrator. Format Builder
adds new features, and its default version is 2.0.

Apply Saves your changes to the message format document.
Reset Discards your changesto the detail window and resetsall fieldsto the
last saved values.
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Valid Names

Message Formats, Fields, and Groups are identified by a Name. The name that is
specified is used asthe XML tag when binary dataistrandated to XML by XML
Trandator. Thus the name must conform to the XML rules for aname.

The rules for names are as follows:
m  Must start with aletter or underscore

m  Can contain letters, digits, the period character, the hyphen character, or the
underscore character.

The following are valid name examples:

M/Fi el d

M/Fi el d1

M/Fi el d_agai n
MyFi el d- agai n

The following are invalid name examples:

1MFi el d - may not start with a digit
My/>Fi el d - the greater-than sign (>) isanillegal character
M/ Fi el d - aspaceis not permitted

Creating a Group

Groupsare collectionsof fields, comments, referencesand other groupsthat arerelated
in some way (for example, the fields PAYDATE, HOURS, and RATE could be part of the
PAYI NFOgroup). Y ou can create a group as a child of the message format item, as a

child of another group, or asa sibling of a group or field.
To create agroup:

1. Select anitem in the tree pane.

2. Choose Insert — Group — As Child if you want to create the group as the child of
the message format or another group. Choose Insert - Group — As Sibling if you

want to create the group as the sibling of another group or afield. The Group
Details display in the detail window.
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Figure2-5 Group Details
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3. Enter datain the fields as described in the following table.

Note: The following example appliesto MFL version 2.0.

Field Description

Group Description

Name The name of the group. This name must comply with XML element
naming conventions.

Optional Choose Optional if thisisan optiona group.

Choice of Children Choose Choiceof Childrenif only oneof theitemsin the group will
be included in the message format.

Group Occurrence
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Field

Description

Occurrence

Choose one of the following to indicate how often this group
appears in the message format:

m  Once— Indicates the group appears only once.

m  Repeat Delimiter — Indicates the group will repeat until the
specified delimiter is encountered.

m  Repeat Field — Indicates the group will repeat the number of
times specified in the repeat field.

m  Repeat Number — Indicates the group will repeat the
specified number of times.

m  Unlimited — Indicates the group will repeat an unlimited
number of times.

Note:  Unlessagroup isdefined as Optional, all groups occur at
least once.

Group Delimiter

Delimited

Select thisoptionif the end of the group is marked with adelimiter.
A delimiter identifies the end of a group of fields.

Note:  Normally, groups are not delimited. They are usually
parsed by content (the group ends when al child objects
have been parsed).

Delimiter is Shared

Indicatesthat the delimiter marks both the end of the group of data,
and the end of the last field of the group. The delimiter is shared
among the group and the last field of the group, to delimit the end
of the data.

Delimiter Tab

Groups can have their termination point specified by adelimiter. A
delimiter isastring of charactersthat marksthe end of the group of
fields. The group continues until the delimiter characters are
encountered.

Value — Enter the delimiter that marks the end of the group of
fields.
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Field

Description

Delimiter Field Tab

Groups can have their termination point specified by afield that
contains adelimiter character string. A delimiter isa string of
charactersthat mark the end of the group. The group continuesuntil
the delimiter character string contained in the specified field is
encountered.

m  Field — Select thefield that contains the delimiter character
string. A list of valid fields will be presented in a drop-down
list.

m Default — Enter the default delimiter character that will be
used if the above field is not present in the data. Thisvalueis
required.

Group Update Buttons

Apply

Saves your changes to the message format document.

Duplicate

Makesacopy of thegroup currently displayed. Theduplicate group
contains the same values as the original group. The name of the
duplicate group is the same as the original group name, with the
word “New” inserted before the original name. For example,
duplicating agroup called “Groupl” resultsin a group with the
name “NewGroupl”.

When you duplicate an item with anumeric valuein its name, the

new item name contains the next sequential number. For example,
duplicating “NewGroupl” resultsin agroup named “NewGroup2”.

Reset

Discards your changes to the detail window and resets dl fieldsto
the last saved values.

Creating a Field

Fieldsare aseguence of bytesthat have some meaning to an application. (For example,
the field EMPNANE contains an employee name.) Y ou can create afield asachild of the
message format item, as a child of agroup, or as a sibling of a group or another field.
The field name is used as the element name in the XML document and must comply

with XML naming conventions.
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To create afield:
1. Select anitem in the tree pane.

2. Choose Insert - Field - As Child if you want to create the field as the child of the
message format or group. Choose Insert - Field » As Sibling if you want to
create the field as the sibling of another field or a group. The Field Details
display in the detail window.

Figure2-6 Field Details

Field Description

Name [PR_Mumber | O optional
[C] Tagged
Type |Numeric - |

Field Occurrence
® Once
' Repeat Delimiter
2 Repeat Field
! Repeat Number
) Unlimited

Field Data Options
Termination

[Length [ Delimiter [[Length Field [[Delimiter Field |

walue | |

Code Page | Default - Codepage of the run-time platform -

| Apply || Duplicate || Reset |

3. Enter datain the fields as described in the following table.

Note: The following example appliesto MFL version 2.0.
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Field

Description

Field Description

Name The name of the field. This name must comply with XML element
naming conventions. Refer to Valid Names for more information.

Optional Select thisoptionif thisisan optiona field. Optional meansthat the
datafor the field may or may not be present.

Tagged Select thisoption if thisisatagged field. Being tagged meansthat a
literal precedes the data, indicating that the datais present. You
must also choose the data type of the tag field from the drop-down
list box. For example: SUP: ACMVE | NC, SUP: isthetag. ACME
INC isthefield data.

Tag If you selected the Field is Tagged option, enter the tag here.

Type Select the datatype of thefield from the drop- down list. The default

is String.
Note: TheField Type you select dictates the Field Data Options
that appear on the dialog.

Refer to Appendix A, “Supported Data Types,” for alist of data
types supported by XML Trandator.

Field Occurrence

Occurrence

Choose one of the following to indicate how often thisfield appears
in the message format:

m  Once— Indicates the field appears only once.

m  Repeat Delimiter — Indicates the field will repeat until the
specified delimiter is encountered.

m  Repeat Field — Indicates the field will repeat the number of
times specified in the field denoted as the repeat field.

m  Repeat Number — Indicates the field will repeat the
specified number of times.

m  Unlimited — Indicates the field will repeat an unlimited
number of times.

Note: Unlessafieldisdefined asoptional, thefield will occur at
|least onetime.
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Field Description

Note: Thefieldsthat display in the following sections of the dialog depend on the Field
Type selected.

Field Data Options

Data Base Type If thefield isadate or time field, the base type indicates what type
of characters (ASCII, EBCDIC, or Numeric) make up the data.

Y ear Cutoff If thefield isadate field that has a 2-digit year, the year cutoff
alowsthe 2-digit year to be converted to a4-digit year. If the 2-digit
year isgreater than or equal to theyear cutoff value, a'19’ prefix will
be added to the year value. Otherwise a'20’ prefix will be used.

Code Page The character encoding of the field data.

Value The value that appearsin aliteral field.

Field Delimiter (Termination)

Length Tab Variable-size datatypes can havetheir length specified by aspecific
length value.

Value — Enter the length of the field data.

Delimiter Tab Variable-sized datatypes can have their termination point specified
by adelimiter. A delimiter is a character that marks the end of the
field. The field data continues until the delimiter character is
encountered.

Value — Enter the delimiter that marks the end of the field data.
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Field

Description

Length Field Tab

Variable-sized datatypes can havetheir termination point specified
by alengthfield. A length field precedesthe datafield and indicates
how many bytes the data contains.

m  Type— Select the type of the length field.

m  Length — Select thisoption if the length field isavariable
length; then, enter the number of bytes in the length field.

m  Ddimiter — Select thisoption if the end of the length field is
marked by a delimiter; then, enter the delimiter character.

m  Length OccursBefore Tagged Field — Select this option if
the length field should appear before the tag in the data. The
default order is tag before length.

Note:  The Length and Delimiter selection will be disabled if the
type of the length field determinesiits length (see
Supported Data Types for more information on field

types).

Delimiter Field Tab

Variable-sized datatypes can have their termination point specified
by afield that contains adelimiter character. A delimiter isa
character that marks the end of the field. The field data continues
until the field containing the delimiter character is encountered.

m  Field — Select the field that contains the delimiter character.

m  Default — Enter the delimiter character. Y ou must supply a
default value. Thedefault is used when the delimiter field is not
present.

Field Update Buttons

Apply

Saves your changes to the message format file.

Duplicate

Makes a copy of the field currently displayed. The duplicate field
contains the same vaues as the original field. The name of the
duplicate field is the same as the original field name, with the word
“New” inserted before the origina name. For example, duplicating
afield called “Field1” resultsin afield with the name“ NewField1”.

When you duplicate an item with anumeric valuein its name, the
new item name contains the next sequential number. For example,
duplicating “NewField1” resultsin agroup named “NewField2”.

Reset

Discards your changes to the detail window and resets all fieldsto
the last saved values.
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Creating a Comment

Comments contain notes about the message format or the data trandated by the
message format. Comments are included in the message format definition for
documentation and informational purposesonly. Y ou can create acomment asachild
or sibling of any message format, group, or field. Comments are unnumbered in the
MFL document and are not transformed to the XML or Binary data.

Note: Conventionally, the comment usually precedes the node it intends to
document.

To create a comment:
1. Select anitem in the tree pane.

2. Choose Insert - Comment — As Child if you want to create the comment as the
child of the selected item. Choose Insert - Comment — As Sibling if you want to
create the comment as the sibling of the selected item. The Comment Details
display in the detail window.

Figure2-7 Comment Details

Comment Details

HYZ Corporation legacy Purchase Request farmat.

oy || o |

3. Enter datain the fields as described in the following table.

Field Description
Comment Details Enter the comment text.
Apply Saves your changes to the message format document.
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Field Description

Reset Discards your changes to the detail window and resets all
fields to the last saved values.

Creating References

References indicate that the description of the field or group format has been
previously defined and you want to reuse this description without re-entering the data.
Referencefields or groups have the same format asthe original field or group, but you
can change only the optional setting and the occurrence setting for the reference field
or group. For example, if you have a“bill to” address and a“ship to” addressin your
data and the format for the addressis the same, you only need to define the address
format once. Y ou can create the “ bill to” address definition and create a reference for
the “ship to” address.

Note: References are named exactly the same asthe original item. For example, the
“bill to” address definition and the “ship to” address definition would be
named the same. If you want to reuse agroup definition, create ageneric group
and embed it within a specific group. For example, in the previous example,
you can create an address group within abill_to group and reference address
within aship_to group.

To create areference;

1. Select afield or group in the tree pane.
2. Choose Edit — Copy.

3. Choose the proper sibling in the tree.
4. Choose Edit - Paste » As Reference.
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Figure2-8 Reference Details

Hame

® Once

) Repeat Delimiter
| © Repeat Field

) Repeat Number
) Unlimited

Group Reference Description

[_| Dptional

Group Reference Occurence

| Apphy H Edit Reference H Reset ‘

5. Enter datain the fields as described in the following table.

Field Description

Reference Description

Name Displays the name of the original field for group for which you
created this reference. This value cannot be changed.

Optional Select this option if the reference field or group is optional.

Occurrence

Occurrence Choose one of the following to indicate how often this

reference field or group appears in the message format:

Once — Indicates the reference appears only once.

Repeat Delimiter — Indicatesthereferencewill repeat until the
specified delimiter is encountered.

Repeat Field — Indicates the reference will repeat the number
of times specified in the field denoted as the repeat field.
Repeat Number — Indicates the reference will repeat the
specified number of times.

Unlimited — Indicates the reference will repeat an unlimited
number of times.
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Field Description

Field Update Buttons

Apply Saves your changes to the message format document.

Edit Reference Displays the detail window for the original item so you can edit the
details of the referenced field or group.

Reset Discardsyour changesto the detail window and resetsall fieldsto the
last saved values.

Working with Pallets

The pallet allows you to store commonly used message format items and insert them
into your message format definitions. Theseitemsare stored inan MFL document, and
you can use the drag and drop feature (see Using Drag and Drop) to copy items from
the pallet into your message format definition.

Y ou may reorder or change the hierarchy within the pallets by using drag and drop or
the Context menu. The contents of the pallet are automatically saved when you exit
Format Builder.

Note: You can only copy items from the tree pane to the pallet and vice versa. You
cannot move items between the windows.

The XML Translator pallet contains some common date formats, literals, and strings.
Y ou can use theseitemsin the message formats you create, aswell asadding your own
itemsto the pallet.

Adding Items to the Pallet

To add items to the pallet:

1. Choose View — Show Pallet to display the pallet.
Note: If the Pallet window is already displayed, skip this step.

2. From the tree pane of the XML Trandator window, choose the item you want to
add to the pallet.
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Click and hold the left mouse button and drag the item into the pallet window.

When the item is placed in the position you want it (as sibling of the desired
item), release the mouse button. Theitem is copied from the XML Trandator
window to the pallet window.

Notes: Y ou cannot add any node that depends on the existence of another node to the

pallet. For example, you cannot add Field or Group References, and you
cannot add items that have a Repeat Field specified.

Adding commentsis possible, but not recommended since comments do not
have unique names and therefore are indistinguishable on the pallet.

Deleting Items From the Pallet

To delete items from the pallet:

1

Select the item in the pallet to be deleted and click the right mouse button. The
Shortcut Menu displays.

Choose Delete. A message displays asking you to confirm the deletion.
Click OK to delete theitem.

Adding Pallet Items to a Message Format

To copy items from the pallet to a message format:

1

Choose View — Show Pallet to display the pallet.
Note: If the Pallet window is already displayed, skip this step.

From the pallet window, choose the item you want to add to your message
format.

Click and hold the left mouse button and drag the item into the tree pane of the
Format Builder window.

When the item is placed in the position you want it (as the sibling of the desired
item), release the mouse button. Theitem is copied from the pallet to the message
format.
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Saving a Message Format

To save amessage format file for the first time:

1. Choose File— Save As. The Save As diaog displays.

Figure2-9 SaveAsDialog

Look in: |ﬁpu v| @ @ @ oo

File narne; | | Save As

Files of tyne: | MFL Files (*mfl) v|| Cancel |

2. Navigate to the directory where you want to save the file.
3. Inthe File Name text box, type the name you want to assign to the file.

4. Format Builder automatically assigns the .mfl extension to message format files
by default if no extension is given.

5. Click Save Asto save thefile in the specified |ocation with the specified name
and extension.

To save a message format file using the same name, choose File - Save. Thefileis
saved in the same | ocation with the same name and extension.

To save amessage format file using a different name, choose File - Save Asand
follow steps 1 through 5 above.
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Opening an Existing Message Format

To open an existing message format file:
1. Choose File— Open. The Open dialog displays.

Figure2-10 Open Dialog

Lookin: | CJwikft1.0 ~| [=] [@] =] [sa )8
3 UninstallerData

T apidoc

3 doc

Ijhelp

3 samples

File name: | | Open
Files of tyne: | MFL Files (mfl) ~| | cancer |

2. Navigate to the directory containing the desired file and select the file name.

3. Click Open. Thefileisloaded into Format Builder.

Importing a COBOL Copybook

XML Trandlator includes afeature that allows you to import a COBOL copybook into
Format Builder creating a message definition to translate the COBOL data. When

importing acopybook, comments are used to document theimported copybook and the
Groups and Fieldsit contains.

To import a COBOL copybook:

1. Choose Tools— Import -~ COBOL Copybook Importer. The COBOL Copybook
Importer dialog displays.
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2% COBOL Copybook Importer
File Hame: || | Browse ...
Byte Order Character Set
[® Big Endian =) EBCDIC
(i Little Endian ) ASCl
| Cancel | | About |

2. Enter datain the fields as described in the following table:

Field Description

Filename Type the path and name of the file you want to import.
Browse Click to navigate to the location of the file you want to import.
Byte Order

Big Endian Select this option to set the byte order to Big Endian.

Note:  These values are attributes of the copybook data, not
the copybook description file.

Little Endian Select this option to set the byte order to Little Endian.

Note:  These values are attributes of the copybook data, not
the copybook description file.

Character Set
EBCDIC Select this option to set the character set to EBCDIC.
Note:  These values are attributes of the copybook data, not
the copybook description file.
ASCII Select this option to set the character set to ASCII.

Note:  These values are attributes of the copybook data, not
the copybook description file.

Action Buttons
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Field Description

OK Imports the COBOL Copybook using the settings you defined.

Cancel Closes the dialog and returns to Format Builder without
importing.

About Displays information about the COBOL Copybook importer

including version and supported copybook features.

Once you have imported a copybook, you may work with it asyou would any message
format definition. If an error or unsupported datatype is encountered in the copybook,

amessageisdisplayedinfo
or save the error to alog fil

rming you of the error. Y ou can choose to display the error
efor future reference.

Setting Format Builder Options

You can set several optionsto control the overall operation of Format Builder.

To set Format Builder options:

1. Choose Tools— Options. The Options dialog displays.

Figure2-11 Format Buil

der OptionsDialog

T Format Builder Dptions E

Default Message Format Version 200 w

XML Formatting Options
Initial Indent 0
New Line Indent |4

XML Content Model Options
[vl Auto-generate DTD
[C] Auto-generate Schema

2. Enter datain thefields
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Field

Definition

Default Message Format Version

Select the MFL version used when creating new
documents.

Note:  Message formats contain their own format

version specified on the Message Format pane.

XML Formatting Options

Initial Indent

Enter the number of spacesto indent the first line of the
Message Format document.

New Line Indent

Enter the number of spacesto indent anew child line of
the Message Format document.

XML Content Model Options

Auto-generate DTD

Generates a DTD document when you save the MFL
document. This document will be placed in the same
directory as the message format.

Auto-generate Schema

Generatesan XML Schemafile when you savethe MFL
document.This document will be placed in the same
directory as the message format.

Action Buttons

OK

Saves your changes and closes the dialog.

Cancdl

Discards your changes and closes the diaog.

Format Builder Menus

The following menus are available in Format Builder.
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File Menu
The following commands are available from the File Menu.
Note: Some commands may be unavailable, depending on the actions you have
taken.
Menu Command Description
New Creates a new Message Format document.
Open Opens an existing Message Format document.
Close Closes the current Message Format document.
Save Saves the current Message Format document.
Save As Saves the current Message Format under a different name
document.
Exit Exits the Format Builder program.
Edit Menu

The following commands are available from the Edit Menu.

Note: Some commands may be unavailable, depending on the actionsyou havetaken
and the state of the tree pane and its items.

Menu Command Description

Undo Reverses the previous action. The Undo command in the Edit
Menu changes to indicate the action that can be undone. For
example, changing the name of afield to Field1 and clicking
Apply causes the Edit Menu to read “Undo Apply Field Field1”.
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Menu Command

Description

Redo

Reverses the effects of an Undo command. The Redo command
in the Edit Menu changes to indicate the action that can be
redone. For example, changing the name of afield to Field1 and
then undoing that action causes the Edit Menu to read “Redo
Apply Field Fieldl”.

Cut

Removes the item currently selected in the left-hand pane, and
it's child objects, from the tree. Thisitem is placed on the
clipboard for pasting into another location.

Note:  Thisaction isnot availableif the Message Format
(root) item is selected.

Copy

Makes acopy of theitem currently selected in the | eft-hand pane
for insertion elsewhere in the tree.

Note: Thisaction isnot availableif the Message Format
(root) item is selected.

Paste

Insertsthe cut or copied item. An additional menu displayswhen
you select Paste. Y ou can choose to paste the item as a child or
sibling of the selected item. In addition, you can chooseto paste
areference as asibling of the selected item.

Duplicate

Makes acopy of theitem selected in the tree. The duplicateitem
contains the same values as the original item. The name of the
duplicate item is the same as the original item name, but the
word “New” isinserted before the original name. For example,
duplicating anitem called “Field1” resultsin an item with the
name “NewFieldl”.

When you duplicate an item with a numeric value in its name,
the new item name contains the next sequential number. For
example, duplicating “NewGroupl” results in a group named
“NewGroup2”.

Delete

Deletes the item selected in the tree, aswell as al child objects
of that item.

Move Up

Moves the selected item up one position under its parent.

Move Down

Moves the selected item down one position under its parent.
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Menu Command

Description

Promote

Promotes the selected item to the next highest level in the tree.
For example, Field1 isthe child object of Groupl. Selecting
Field1 and clicking the Promote tool makesit a sibling of
Groupl.

Demote

Demotes the selected item to the next lower level inthetree. For
example, Groupl isthe sibling of Field1. Fieldl immediately
follows Groupl in the tree. Selecting Field1 and clicking the
Demote tool makesit a child of Groupl.

Insert Menu

The following commands are available from the Insert Menu.

Menu Command

Description

Field

Inserts anew field. Y ou can choose whether to insert the
field asachild or sibling of the item selected in the tree.

Group

Inserts a new group. Y ou can choose whether to insert the
group as achild or sibling of the item selected in the tree.

Comment

Inserts acomment. Y ou can choose whether to insert the
comment as achild or sibling of the item selected in the
tree.

View Menu

The following commands are available from the View Menu.

Menu Command

Description

Show Pallet

Displays the pallet window. For more information on the
pallet, see Working with Pallets.

Expand All

Expands the entire tree pane to show the child objects of all
itemsin the tree.
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Menu Command Description
Collapse All Collapsesthe entiretree paneto show only theroot message
format.

Tools Menu

The following commands are available from the Tools Menu.

Menu Command Description

Import Displaysalist of the installed importers. Choose the
importer from which you want to import a message.

Options Displays the Format Builder Options dialog. For more
information, see Setting Format Builder Options.

Test Menu
The following command is available from the Test Menu.
Menu Command Description
Message Format Opens the Format Tester. Refer to “ Testing Format
Definitions’ for more information.
Help Menu

The following commands are available from the Help Menu.

Menu Command Description
Help Topics Displays the main Help screen.
How Doll. .. Provides step-by-step instructions for performing the

basic tasks in Format Builder.
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Menu Command Description
About Displays version and copyright information about Format
Builder.
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3 Testing Format
Definitions

Once you have built aformat definition, you can test it using the built-in test feature of
Format Builder. The test feature parses and reformats data as a validation test and also
generates sample binary or XML data. Using the Tester, you can make sure the
message formats you build with Format Builder produce the expected results. The
Tester uses the runtime WLXT Java class to perform the test trandation.

This section discusses the following topics:
m  Running the Tester

m  Debugging Formats

Running the Tester

To run the tester:

1. Start Format Builder.

Note: To run the Tester, you must have a message format document open in the
Format Builder.

2. Choose Test — Message Format. The Format Tester dialog displays.
Note: The Tester works with the currently loaded message definition document.
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Figure3-1 Format Tester Dialog

B Format Tester =[O x|

MFL Document file/Ciibeatwhftl 0/samplesipoipo xml

~ Binary ~ XML

[ »
[ »

[] Debug

1]
l

3. Load adatafilein the binary or XML edit control or enter your own data

Field Description

MFL Document Displays the name of the message format definition currently
loaded in Format Builder.

Binary

Load Allows you to select the binary datafile you want to work
with.

Save Allows you to save the binary datato afile.

Generate Automatically generates binary test data based on the current
message format definition.

Clear Clears the data from the display area.
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Field

Description

Display Area

Displays the results of loading or translating afile. You can
a so enter your own data or modify data you have entered.

Note:  Clicking the right mouse button in this display area
opens a shortcut menu. From this menu, you can
choose the Cut, Copy, or Paste commands. These
commands allow you to cut or copy text displayedin
this area and paste it in another location within this
display area.

Action Buttons

To XML Tranglates the binary datain the currently loaded fileto XML
format, based on the current message format definition.
To Binary Translatesthe XML datain the currently loaded file to binary
format, based on the current message format definition.
Debug Select thisoption if you want to display the actions the Tester
performs during atrandation.
XML
Load Allowsyouto select the XML datafileyou want to work with.
Save Allows you to save the XML datato adifferent filename.
Generate Automatically generates XML test data based on the current
message format definition.
Clear Clears the data from the display area.
Display Area Displays the results of loading or translating afile. You can
a so enter your own data or modify data you have entered.
Note:  Clicking the right mouse button in this display area
opens a shortcut menu. From this menu, you can
choose the Cut, Copy, or Paste commands. These
commands allow you to cut or copy text displayedin
this area and paste it in another location within this
display area.
Debug
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Field Description
Debug Display Area Displays the actions being performed by the Tester during a
translation.

Debugging Formats

Thefollowing stepsillustrate using the Tester to debug a message definition that does
not trandate correctly.

To debug a message definition:
1. Start Format Builder.
2. Open a Message Format.

3. Open the Tester dialog box and load the file (either XML or binary) that you
want to trandate.

4. Select Debug. The Debug text box opens at the bottom of the Format Tester
dialog.

5. Click the appropriate button (to XML or to Binary) to trandate your data. The
Debug window displays the actions that take place during the translation
operation, including any errors that are encountered. The field and group values
will be displayed along with delimiters. To determine the location of the error,
determine the last field that parsed successfully and examine the specification of
the next field on the Tree Pane of Format Builder.
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E;a Format Tester

MFL Document filedDiheatwlxd . Ofsamplesipoipo.xml

Binary

| Load || Save || Generate || Clear |

tin

1234,88844321,5UP: 21 Sprockley's Sprockets0151 50 |

XML

- [Of ]

| Load || Save || Generate || Clear |

2000123 Main 5t AustingTH, 75222555 State 5t Aus
inTHFa222,P0O12345678 6661231580 Red Sprocke

to XML =

< to Binary

1]

Debug:

[vl Debug

TR T T
=Purchase_Qrder=
=PO_Mumher=12345678=/PO_Number=
=iPurchase_oOrder=
=/Payment_Terms=
=Purchase_lterms=
=ltern=
=Part_MNumhber=666123=/Part_Mumber=
=Quantity=150=/Guantity=
=Description=Red Sprocket=iDescription=
=flterm=
=/Purchase_ltems=
=iPurchaseRequest=

-

Farsing FieldFormat PR_Mumber at offset 0
FieldFormat PR_Mumber Found delimiter [}]

Done FieldFormat PR_Mumber

Field PR_Mumber type Mumeric offzet 0 value=[1234]

EID

1]

o c " L T-N—t L

\Errors encountered during translation process

6. Correct the errors and test the trandation again.

7. Continue this process until the tranglation is successful.

Note: You canleave the Tester dialog box open while you modify the Message
Format from within Format Builder. Any changes to the message definition
are automatically used by the Tester.
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Binary to XML

4 Using the Run-Time
Component

The run-time component of XML Translator consists of a Java class named WLXT.
This class has various methods used to trandl ate data between binary and XML
formats. This Java class can be deployed in an EJB using BEA WebL ogic Server,
invoked from aworkflow in BEA WebL ogic Process Integrator, or integrated into any
Java application.

The XML Translator class provides several par se() methods that trandate binary
datainto XML. XML Translator also provides several seri al i ze() methods that
translate XML datato a binary format. Binary data formats are described viaMFL
documents. XML Trandlator uses MFL documents to read and write binary datato or
from XML. MFL documents are specified by aURL inaparse() orseri al i ze()
method. The code samplesbelow illustrate how to use XML Trand ator to parse binary
datainto XML, and serialize XML into binary.

Binary to XML

Thefollowing code listing uses the par se() method of XML Tranglator to parse afile
containing binary datainto XML.

Listing4-1 SampleBinary to XML Parse() Method

1 inmport com bea.w xt.*;
2 inport org.w3c.dom Docunent;
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import java.io.FilelnputStream
i mport java.net.URL;

{
public static void main(String[] args)
{
10 try
11 {
12 WLXT Wl xt = new WLXT();
13 URL nfl Docunent Nane = new URL(“file:nynfl.nfl");
14 FilelnputStreamin = new Fil el nput Strean(“nybi naryfile”);

3
4
5
6 public class Exanple
7
8
9

16 Docunent doc = w xt. parse(nfl Docunment Name, in, null);
17 String xm = w xt.get XM_Text (doc, 0, 2);
18 System out. println(xnm);

20 catch (Exception e)
21 {
22 e.printStackTrace(Systemerr);

In the prior listing, a new instance of the XML Translator classisinstantiated at line
12. A Uniform Resource Locator (URL) is created for aMFL file that was previously
created with Format Builder. A FilelnputStream is created for some binary data that
existsinthefilenybi naryfil e. The URL for the MFL document, and the stream of
binary data, are then passed into the parse method of XML Translator at line 16. The
parse method converts the binary data into an instance of a \W3C Document object.
Thisobject can be converted to XML text viaXML Trandator get XML Text () method
(asshown on line 17), or manipulated directly viathe W3C DOM API.

Generating XML with a Reference to a DTD

WXLT aso includes par se() methodsthat allow areference to a Document Type
Definition (DTD) or an XML Schemato be output in the resulting XML document.
Thefollowing listing illustrates this generation.
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Listing4-2 Sample XML Generation with a DTD Reference Code Example

i mport com bea.w xt.*;

i mport org.w3c. dom Docunent

i mport java.io.FilelnputStream
i mport java. net. URL;

public class Exanpl e2

public static void main(String[] args)

©CoO~NOOAWNPE
~

{
10 try
11
12 WXT W xt = new WLXT();
13 URL nfl Docunent Name = new URL(“file:nynfl.nfl");
14 FilelnputStreamin = new Fil el nput Strean(“nybi naryfile”);
15
16 Docunent doc=wl xt . par se(nf | Docunment Nane, i n, “nmydtd. dtd”,
17 null);String xm = w xt.get XM.Text (doc, 0, 2);
18 System out. println(xnm);
19 }
20 catch (Exception e)
21 |
22 e.printStackTrace(Systemerr);
23}
24 '}
25}

The only difference between Listing 4-2 and Listing 4-1 occursin line 16. On line 16,
adifferent parse method is invoked that allows a DTD file to be specified
(mydt d. dt d), so that it is referenced in the resulting XML document.

Thus, the resulting XML has a DOCTY PE statement that refers to the DTD
mydt d. dt d (see the following example).

<?xm version="1.0"7?>
<! DOCTYPE soneRoot Node SYSTEM ‘ nmydtd. dtd’ >

A similar parse method allows the resulting XML to refer to an XML Schema.
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Passing in a Debug Writer

All of thepar se() methods of XML Trandlator allow a PrintWriter to be passedin as
the last parameter of the par se() method. If this parameter is not null, XML
Tranglator will print debug messages to this PrintWriter. This allowsyou to debug the
tranglation if the MFL document and the binary data do not agree. If debug messages
are not desired, passin null for this parameter as shown in the previous listings.

Listing 4-3 Passingin a Debug Writer Sample

i mport com bea.w xt.*;

i mport org.w3c.dom Docunent
import java.io.FilelnputStream
inmport java.io.PrintWiter;

i mport java.net. URL;

public class Exanpl e3

OCoOoO~NOOODWNE
—~

public static void main(String[] args)

10 {

11 try

12 {

13 WXT W xt = new WLXT();

14 URL nfl Docurment Name = new URL(“file:nmynfl.nfl”);

15 Fil elnputStreamin = new Fil el nput Stream

16 (“mybinaryfile”);

17 Docurment doc=wl xt . par se(nfl Docunent Nane, i n, new
PrintWiter(Systemout,true));

18 String xm = w xt.get XM_Text (doc, 0, 2);

19 Systemout. println(xm);

20 }

21 catch (Exception e)

22 {

23 e.printStackTrace(Systemerr);

24

25 }

26 }
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At line 17, as alast parameter to the par se() method, a PrintWriter object is created
from the System.out PrintStream. This will cause debug messages such as the ones
shown below to be written to the console.

Listing 4-4 Debug Output

Parsing Fi el dFormat NAME at offset O
Field NAME Found delimter [;]
Field NAME type String offset 0 val ue=[ John Doe]
Done Fi el dFor mat NAMVE
Group PAYI NFO repeat until delime[*]
Parsing 1st instance of StructFormat PAYI NFO at offset 18
Parsi ng Fi el dFormat PAYDATE at offset 18

XML to Binary

The following code listing illustrates using XML Translator to convert XML text to
binary format.

Listing4-5 Sample XML to Binary Conversion

i mport com bea.w xt.*;

i mport java.io.FilelnputStream

i mport java.io.FileQutputStream
i mport java. net. URL;

public class Exanpl e4
{
public static void main(String[] args)

{
10 try

O©CoO~NOULDWNPEP

12 WXT W xt = new WLXT();
13 URL nfl Docurment Name = new URL(“file:nmynfl.nfl");
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14 FilelnputStreamin = new Fil el nput Stream(“nmyxm .xm");

15 Fi | eQut put Stream out = new Fi |l eQut put Strean(“nybi naryfile”);
16

17 w xt.serialize(nfl Docunent Nane, in, out, null);

18 out.close();

}
20 catch (Exception e)
21 {
22 e.printStackTrace(Systemerr);
23}

In the code example above, a new instance of XML Trandator classis created at line
12. Then aURL iscreated for an MFL file, and aFi | el nput St r eamis created for a
filecontaining XML text. A Fi | eQut put St r eamisalsoinstantiated to storethe binary
datathat will result from the XML to binary translation. Online 17, theseri al i ze()
method of XML Trandlator isinvoked, to translate the XML data contained in the

Fi | el nput Stream’in’ (nyxm . xm ), to the binary format described in'nmynf 1 . nf 1.
This binary dataiswritten to the FileOutputSream 'out’ (which isthefile

'mybi naryfile’).

Converting a Document object to Binary

Thelisting below illustrates converting a W3C Document object to a binary format.

Listing4-6 Converting a Document Object to Binary

i mport com bea.w xt.*;

i mport java.io.FileQutputStream
i mport java. net. URL;

i mport org.w3c. dom Docunent ;

i mport org. apache. xer ces. par sers. DOVPar ser ;

©CoOoO~NOOOThA,WNE

public class Exanpl e5
10 {
11 public static void main(String[] args)
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/1 Parse XML into a Docunent object
Docunent doc = null;
try
{
DOVPar ser parser = new DOWParser ();
parser. parse("nmyxm . xm");
doc = parser.getDocunent();

catch (Exception e)

{
e.printStackTrace(Systemerr);
Systemexit(1);

}

try
{
WXT W xt = new WLXT();
URL nfl Docurment Name = new URL("file:mynfl.nfl");
Fi | eQut put Stream out = new
Fi | eCQut put Stream("nybi naryfile");

w xt . serialize(nfl Docurent Nane, doc, out, null);
out.close();

catch (Exception e)
{

e.printStackTrace(Systemerr);

}

Thisexampleillustrates passing in a Document object to theseri al i ze() method of
the XML Trandator class. Thisis useful when your application already has XML in
theform of a Document object, or has created a Document object usingthe DOM API.
Lines 14 through 25 convert the XML text in the file 'myxni . xml * to a Document
object using an XML parser. This Document object is passed to XML Trandator on
line 33, to convert it to the binary format specified by the MFL file’nynfl . nfl".
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Passing in a debug writer

The serialize methods al so support passing in a PrintWriter parameter for the logging
of debug messages. An exampleinvocation of the serialize method with a PrintWriter
object is given below.

w xt . serialize(nfl Docurent Narme, in, out, new
PrintWiter(Systemout, true));

Thiswill cause debug messages such as the ones shown below to be written to the
console.

Debug Output

The following code represents debug output.

Listing 4-7 Debug Output

Processing xm and nfl nodes tcpl
Processi ng xm node NAVE

Checki ng MFL node NAME

Found mat chi ng MFL node NAME
Witing field NAVE val ue John Doe
Processi ng xm node PAYI NFO
Checki ng MFL node PAYI NFO

XML to XML Transformation

XML Trandator also provides methods to transform XML viaXSLT. XSLT isa
language for transforming XML documents. A XSLT stylesheet isan XML document
that describes transformations that are to be performed on the nodes of an XML
document. The XML Translator class providest r ansf or () methods that apply an
XSLT stylesheet to an XML document. Using a stylesheet, an XML document can be
transformed into HTML, PDF, or another XML dialect.
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Thelisting below illustrates transforming an XML document using one of the
transform methods provided by the XML Translator class.

Listing4-8 XML to XML Transformation

1 inport combea. w xt.*;

2 inport java.io.FilelnputStream

3 inport java.io.FileQutputStream

4 inport java.net.URL;

5

6 inport org.xnl.sax.|nputSource;

7

8 public class Exanpl e7

9

10 public static void main(String[] args)

11 {

12

13 try

14 {

15 WXT W xt = new WLXT();

16 URL stylesheet = new URL("file: nystyl esheet.xsl");
17 FilelnputStreamin = new Fil el nput Strean("nyxm . xm");
18 Fi | eQuput Stream out = new Fi | eQut put St ream

19 (“myout putfile”)

20

21 w xt . transfornm(new I nput Source(in), out, stylesheet);
22

23 out.close();

24 }

25 catch (Exception e)

26 {

27 e.printStackTrace(Systemerr);

28 }

29

30 }

Online 15, an instance of XML Trandator is created. On the following lineaURL is
created for apreviously created XSLT stylesheet. A Fi | el nput St r eamisthen created
for afile containing XML text. A Fi | eQut put St r eamis also created for the text that
results from the XSLT transformation. On line 20, at r ansf or m() method of the
XML Trandlator classisinvoked to transform the XML in thefile myxm . xm ’,
according to the XSLT stylesheet 'nyst yl esheet . xsl . The output of the
transformation is written to thefile 'myout put fil e’.
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Initialization methods

The XML Translator class provides several methods to 'preprocess’ MFL documents
and XSLT stylesheets. Once these documents are preprocessed, they are cached
internally, and reused when referenced in an parse() , seri al i ze(), or

transf or () method. Thisgreatly improvesthe performance of these methods, since
the MFL document or XSLT stylesheet has already been processed and cached. This
is particularly useful when XML Trandator isused in an EJB or servlet, where the
same MFL documents or XSLT stylesheets are used repeatedly.

init() method

The XML Translator class providestwoi ni t () methodsthat take either a
java.util.Properties object or the file name of a Propertiesfile as a parameter. This

i ni t () method will retrieve the W.XT. st yl esheet s’ and "W.XT. MFLDocunent s’
properties from the Properties object. Each property is expected to contain a
comma-delimited list of documents that are to be preprocessed and cached. When
these documents are later referenced in aparse(), seri al i ze(), ort ransf orm()
method, the preprocessed version will be retrieved from the cache. The listing below
demonstratesusing ani ni t () method to initialize an instance of the XML Trandator
class.

Listing 4-9 Propertiesfile myconfig.cfg:

WLXT. MFLDocunent s=fil e: mynfl . nfl
WLXT. styl esheet s=fil e: nystyl esheet. xsl

Listing 4-10 Source code example of init() method using file’'myconfig.cfg’

i mport com bea.w xt.*;

i mport java.io.FilelnputStream
i mport java.io.FileQutputStream
i mport java. net. URL;

i mport org.xmnl.sax. | nput Source;
i mport org.w3c.dom Docunent ;

©Coo~NOOOPWNERE

public class Exanpl e8
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10 {
11
12
13
14

public static void main(String[] args)

WLXT W xt = null;

/1 Initialize W.XT with a properties file
try

{
w xt = new W.XT();

w xt.init("myconfig.cfg");

catch (Exception e)

{
}

/1 Parse binary data into XM
Docunent doc = null;

try

{
URL nfl Docunent Name = new URL("file:nmynfl.nfl");
FilelnputStreamin = new Fil el nput Stream("nybi naryfile");

e.printStackTrace(Systemerr);

doc = W xt. parse(nfl Docunment Narme, in, null);

catch (Exception e)

{
e.printStackTrace(Systemerr);

}

try

{
URL styl esheet = new URL("file: mystyl esheet. xsl");
Fi | eCQut put Stream out = new Fi |l eQut put Stream
(“myout putfile”)
w xt. transforn{doc, out, stylesheet);
out.close();

}

catch (Exception e)

{
e.printStackTrace(Systemerr);

}
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Thei ni t () method on line 20 of thelisting above, causesthe XML Translator object
to preprocess the documents listed in the file 'myconfi g. cf g". When an MFL
document is specified in the par se() method of line 34, this MFL document has
already been processed an cached inside the XML Translator object. The sameistrue
of the stylesheet that is referenced in the invocation of thet r ansf or m() method on
line 46.

Java APl Documentation

For the compl ete reference to using the XML Tranglator class, see the Java API
Documentation located in the api doc subdirectory of your XML Translator
installation.
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APPENDIX

A Supported Data Types

This section lists the following data types supported by XML Trand ator.

m MFL Data Types

m COBOL Copybook Importer Data Types

MFL Data Types

Table A-1 liststhe MFL datatypes that XML Tranglator supports. These types are
specified in the type attribute of a FieldFormat element.

Table A-1 Supported MFL Data Types

Data Type

Description

String

A string of characters. Requires alength, alength field, a
delimiter, or adelimiter field. If no length, length field, or
delimiter is defined for a data type String, a delimiter of "\x00"
(aNUL character) will be assumed.

String: NUL terminated

A string of characters, optionally NUL (\x00) terminated,
residing within afixed length field. Thisfield type requires a
length attribute or length field which determines the amount of
dataread for the field. This datais then examined for aNUL
delimiter. If adelimiter isfound, datafollowing the delimiter is
discarded. If aNUL delimiter does not exist, the fixed length
datais used as the value of the field.
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Data Type

Description

Numeric

A string of characters containing only digits, i.e. ‘0’ through ’9'.
Requires alength, length field, delimiter, or adelimiter field.

Binary (Base64 encoding)

Any character value accepted. Requires alength, length field,
delimiter, or adelimiter field. Resulting XML datafor thisfield
is encoded using base-64.

Binary (Hex encoding)

Any character value accepted. Requires alength, length field,
delimiter, or adelimiter field. Resulting XML datafor thisfield
is encoded using base-16.

EBCDIC

A string of charactersin IBM Extended Binary Coded Decimal
Interchange Code. Requires alength, length field, delimiter, or
adeimiter field.

Packed Decimal: Signed

IBM signed packed format. Requires a length, length field,
delimiter, or adelimiter field to be specified. The length or
length field should specify the size of thisfield in bytes.

Packed Decimal:
Unsigned

IBM unsigned packed format. Requires alength, length field,
delimiter, or adelimiter field to be specified. The length or
length field should specify the size of thisfield in bytes.

Zoned Decimal: Signed

IBM signed zoned decimal format. Requires alength, length
field, delimiter, or adelimiter field to be specified. Thelength or
length field should specify the size of thisfield in bytes.

Zoned Decimal: Leading
sign

IBM signed zoned decimal format wherethe signindicator isin
the first nibble. Requires alength, length field, delimiter, or a
delimiter field to be specified. The length or length field should
specify the size of thisfield in bytes.

Zoned Decimal: Leading
separate sign

IBM signed zoned decimal format wherethe signindicator isin
thefirst byte. Thefirst byte only contains the sign indicator and
is separated from the numeric value. Requires alength, length
field, delimiter, or adelimiter field to be specified. Thelength or
length field should specify the size of thisfield in bytes.

Zoned Decimad: Trailing
Separate sign

IBM signed zoned decimal format wherethe signindicator isin
the last byte. The last byte only contains the sign indicator and
is separated from the numeric value. Requires alength, length
field, delimiter, or adelimiter field to be specified. Thelength or
length field should specify the size of thisfield in bytes.
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Data Type

Description

Zoned Decimal:
Unsigned

IBM unsigned zoned decimal format. Requires alength, length
field, delimiter, or adelimiter field to be specified. Thelength or
length field should specify the size of thisfield in bytes.

Integer: Signed, 1 byte

A one byte signed integer, i.e. '56' is 0x38.

Integer: Unsigned, 1 byte

A one byte unsigned integer, i.e. '128’ is 0x80.

Integer: Signed, 2 byte,
Big-Endian

A signed two-byte integer in big endian format, i.e. '4660’ is
0x1234.

Integer: Signed, 4 byte,
Big-Endian

A signed four-byte integer in big endian format, i.e. '4660’ is
0x00001234.

Integer: Signed, 8 bytes,
Big-Endian

A signed eight-byte integer in big endian format, i.e. ‘4660’ is
0x0000000000001234.

Integer: Unsigned, 2 byte,
Big-Endian

An unsigned two-byte integer in big endian format, i.e. '65000’
is OxFDES.

Integer: Unsigned, 4 byte,
Big-Endian

An unsigned four-byte integer in big endian format, i.e. '65000°
is 0x0000FDES.

Integer: Unsigned, 8
bytes, Big-Endian

A unsigned eight-byte integer in big endian format, i.e. '65000’
is 0x000000000000FDES.

Integer: Signed, 2 bytes,
Little-Endian

A signed two-byte integer in little endian format, i.e. '4660’ is
0x3412.

Integer: Signed, 4 bytes,
Little-Endian

A signed four-byte integer in little endian format, i.e. ‘4660’ is
0x34120000.

Integer: Signed, 8 bytes,
Little-Endian

A signed eight-byte integer in little endian format, i.e. '4660’ is
0x3412000000000000.

Integer: Unsigned, 2
bytes, Little-Endian

An unsigned two-byte integer in little endian format, i.e.'65000°
is OXE8FD.

Integer: Unsigned, 4
bytes, Little-Endian

Anunsigned four-byteinteger in littleendian format, i.e. '65000’
is OXE8FD000O.

Integer: Unsigned, 8
bytes, Little-Endian

A unsigned eight-byteinteger in little endian format, i.e. '65000’
is OxE8FD000000000000.
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Data Type

Description

FloatingPoint: 4 bytes,
Big-Endian

A four byte big endian floating point number that conforms to
the |EEE Standard 754.

FloatingPoint, 4 bytes,
Little-Endian

A four byte little endian floating point number that conformsto
the |[EEE Standard 754.

FloatingPoint: 8 bytes,
Big-Endian

A eight byte big endian floating point number that conforms to
the |EEE Standard 754.

FloatingPoint: 8 bytes,
Little-Endian

A eight bytelittle endian floating point number that conformsto
the |EEE Standard 754.

Date: YYYYMMDD

An eight byte numeric string of theformat YYYYMMDD. A
base data of String or EBCDIC may be specified to indicate the
character encoding.

DateTime: A fourteen byte numeric string of the format
YYYYMMDDhhmmss YYYYMMDDHHMISS. A Base data type may be specified.
Date: MMDDY'Y A six digit numeric string defining a date, i.e. 012200.

Date: MMDDYYYY

An eight digit numeric string defining adate, i.e. 01222000.

DateTime: A string of numeric digits defining adate and time, i.e.
MMDDY'Yhhmm 0122001224.

DateTime: A string of numeric digits defining adate and time, i.e.
MMDDY Y hhmmss 012200122400.

Date: MM/DD/YY

A string defining a date, i.e. 01/22/00.

Date: MM/DD/YYYY

A string defining a date, i.e. 01/22/2000.

DateTime: MM/DD/YY
hh:mm

A string defining a date and time, i.e. 01/22/00 12:24.

DateTime: MM/DD/YY
hh:mi AM

A string defining a date and time, i.e. 01/22/00 12:24 AM.

DateTime: MM/DD/YY
hh:mm:ss

A string defining a date and time, i.e. 01/22/00 12:24:00.

DateTime: MM/DD/YY
hh:mm:ss AM

A string defining a date and time, i.e. 01/22/00 12:24:00 AM.
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Data Type

Description

Date: DDMMMYY

A string defining a date, i.e. 22JANOO.

Date: DDMMMYYYY

A string defining adate, i.e. 22JAN2000.

Date: DD/MM/YY

A string defining a date, i.e. 22/01/00.

Date: DD/IMM/YYYY

A string defining a date, i.e. 22/01/2000.

DateTime: DD/MM/YY
hh:mm

A string defining a date and time, i.e. 22/01/00 12:24.

DateTime: DD/MM/YY
hh:mm AM

A string defining adate and time, i.e. 22/01/00 12:24 AM.

DateTime: DD/MM/YY
hh:mm:ss

A string defining a date and time, i.e. 22/01/00 12:24:00.

DateTime: DD/MM/YY
hh:mm:ss AM

A string defining adate and time, i.e. 22/01/00 12:24:00 AM.

Date: DD-MMM-YY

A string defining adate, i.e. 22-JAN-00.

Date: DD-MMM-YYYY

A string defining a date, i.e. 22-JAN-2000.

Date: MMM-YY

A string defining adate, i.e. JAN-00.

Date: MMM-YYYY

A string defining a date, i.e. JAN-2000.

Date: MMMY'Y

A string defining adate, i.e. JANOO.

Date: MMMYYYY

A string defining a date, i.e. JAN2000.

Date: MMMDDYYYY

A string defining adate, i.e. JAN222000.

Time: hhmmss

A string defining atime, i.e. 122400.

Time: hh:mm AM

A string defining atime, i.e. 12:24 AM.

Time: hh:mm

A string defining atime, i.e. 12:24.

Time: hh:mm:ss AM

A string defining atime, i.e. 12:24:00 AM.

Time: hh:mm:ss

A string defining atime, i.e. 12:24:00.
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Data Type

Description

Date: Wed Nov 15
10:55:37 CST 2000

The default date format of the Javaplatform, i.e."WED NOV 15
10:55:37 CST 2000’

Literal

A literal value determined by the contents of the value attribute.
When binary datais translated to XML, the presence of the
specified literal in the binary datais verified by WLXT. The
literal isread, but is not translated to the XML data. When XML
dataistranslated to a binary format, and aliteral is defined as
part of the binary format, WLXT writesthe literal in the
resulting binary byte stream.

Filler

A sequence of bytesthat is not translated to XML. Thisfield of
datais skipped over when trang ating binary datato XML. When
trandating XML to binary data, thisfield iswritten to the binary
output stream as a sequence of spaces.
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COBOL Copybook Importer Data Types

Table liststhe COBOL datatypes and the support provided by the Importer.

Table4-1 COBOL Data Types

COBOL Type Support
BLANK WHEN ZERO (zoned) supported
COMP-1, COMP-2 (float) supported
COMP-3, PACKED-DECIMAL supported
COMP, COMP-4, BINARY (integer) supported
COMP, COMP-4, BINARY (fixed) supported
COMP-5, COMP-X supported
DISPLAY (alphanumeric) supported
DISPLAY numeric (zoned) supported
edited alphanumeric supported
edited float numeric supported
edited numeric supported
group record supported
INDEX supported
JUSTIFIED RIGHT ignored

OCCURS (fixed array) supported
OCCURS DEPENDING (variable-length) supported
OCCURSINDEXED BY ignored

OCCURSKEY IS ignored
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COBOL Type Support
POINTER supported
PROCEDURE-POINTER supported
REDEFINES supported
SIGN IS LEADING SEPARATE (zoned) supported
SIGN ISTRAILING (zoned) supported
SIGN ISTRAILING SEPARATE (zoned) supported
SIGN IS LEADING (zoned) supported
SYNCHRONIZED ignored
66 RENAMES ignored
66 RENAMES THRU ignored
77 level supported
88 level (condition) ignored

Support for these data typesis limited. The following formats:

05 pic 9(5) conp-5
05 pic 9(5) conp-x

will be converted to an unsigned 4 byte integer type, while the following will
generate errors:

05 pic X(5) conp-5
05 pic X(5) conp-x
In these samples, pi c9(5) could be substituted for pi ¢ x(5) .

The following values are defined as follows:

Supported - the data type will be correctly parsed by the importer and converted
to amessage format field or group.

Unsupported - this data type is not supported and the importer reports an error
when the copybook isimported.
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m |Ignored - the datatype is parsed and a comment is added to the message format.
No corresponding field or group is created.

Some vendor-specific extensions are not recognized by the importer, however, any
copybook statement that conformsto ANSI standard COBOL will be parsed correctly
by the Importer. The Importer’s default data model, which is based on the IBM
mainframe model, can be changed in Format Builder to compensate for character set
and data " endianness”.

When importing copybooks, the importer may identify fields generically that, upon
visual inspection, could easily be identified by a more specific datatype. For this
reason, the copybook importer creates commentsfor each field found in the copybook.
Thisinformation is useful in assisting you in editing the MFL data to better represent
the original Copybook. For example:

original copybook entry:

05 birth-date pi cxx/ XX/ Xx
resultsin:

A field of type EBCDI C with alength of 8

Closer inspection indicates that this is intended to be a date format and could be
defined as

A field of type Date: MM/DD/YY
or
A field of type Data: DD/IMM/YY
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Glossary

Binary Data

A fileformat for dataencoded as a sequence of bits, but not necessarily consisting
of asequence of printable characters (text). The term is often used for executable
machine code.

Big Endian

Binary format where most significant byte has the lowest address. Thisformat is
used on IBM 370 and most RISC designs.

COBOL Copybook Importer

Reads a COBOL Copybook and generates a message format reflecting the data
structure of the COBOL Copybook.

Code Page
In the context of this documentation, the character encoding of the field data.

Data Transfor mation

In the context of this documentation, data transformation is the term used to de-
scribe the mapping of XML data to another XML format. An example would be
mapping an instance of a RosettaNet document to an instance of aebXML docu-
ment.

Data Translation

In the context of this application, datatrandation is the process of converting bi-
nary datato or from XML.

Delimiter
A sequence of bytes that denote the end of afield or group of data.

Document Type Definition (DTD)

Defines what content can exist in an XML document. DTDs are part of the W3C
XML Specification 1.0.
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eXtensible Stylesheet Language: Transformations (XSLT)

An XML language designed for transforming one XML document into another.
An XSLT document, or stylesheet, describes data transformations that are to be
performed on nodes of an XML document. Using XSLT, an XML document can
be transformed into avariety of text formats (XML, HTML, PDF, etc.). XSLT is
aW3C recommendation.

Field
A sequence of bytes that are interpreted by an application as a unit of data.

Group
A set of fields and/or groups that are to be treated as having a unifying relation-
ship.

Group Choice

A group comprised of fields or other groups that are mutually exclusive in the ac-
tual binary data.

Java M essage Service (JM S)
A peer-to-peer messaging system for javaprogramsto send and receive messages.
A IMS application is capable of sending or receiving application defined messag-
es (asynchronous requests, reports, or events) to other JM S applications so that
these separate applications can collaborate or coordinate their efforts.

Little Endian

Binary format in which bytes at lower address have lower significance. Thisfor-
mat is used on Intel and VAX processors.

M essage For mat
The description of a binary format produced by Format Builder.

M etadata

Datathat is used to describe other data. Message Formats created using Format
Builder are the metadata used to parse binary data.

M essage Format L anguage (MFL)

An XML language created by BEA that describes the native representation and hi-
erarchy of binary data. MFL isan XML description of binary data.
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Reference

A group or field that relies on a prior definition to determine its name, type, and
termination attributes.

Schema

An XML document that defineswhat can bein an XML document. A Schemadef-
inition is more specific than aDTD and provides much finer-grained control over
the content that can exist in an XML document.

Servlet

A server-side Java program that is usually executed in responseto an HTTP re-
quest and produces its output in a browser.

Stylesheet
An XSL document. A stylesheet describes datatransformations (or mappings) that
areto be performed on an XML document. A stylesheet describes which nodes of
an XML document are to be manipulated (using X Path) and which manipulations
areto be performed.

WebL ogic Process | ntegrator

Workflow engine for BEA WebL ogic application servers that automates work-
flow, business-to-business processes, and application assembly.

WebL ogic Server

WebL ogic’s standards-based, pure-java application server, for assembling, de-
ploying and managing distributed Java applications. WebL ogic Server manages
application components and DBM S connections to ensure security, scalability,
performance, and transaction integrity.

XML - Extensible Markup Language

Dataformat that is easily read and manipulated by both humans and computers;
data and meta-data are both included in the data, to provide a standard self-de-
scribing syntax for representing information. XML isaWorld Wide Web Consor-
tium (W3C) standard.

XPath

Used within XSLT, XPath isan XML language that identifies parts of an XML
document to be processed. XPath isused in XSLT to specify which nodes of an
XML document are to be copied or manipulated during an XSL T transformation.
XPath isa W3C recommendation.
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